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HARDWARE

REQUIRMENTS

Q  IBM 486/Pentium or
compatible

O  3.5” Floppy Drive

O VGA/SVGA monitor

a  16MB RAM
(recommended)

O  33.6K modem
(recommended for e-mail
submission)

SOFTWARE

REQUIRMENTS

Q  MS Windows 95/98 or
NT 4.0

Q  MS Excel 97/98 or
newer

O Internet e-mail
software
(for Internet submissions)

O Internet access
software
(for Internet submissions)

PROGRAM ACQUISITION AND INSTALLATION

Section

Introduction

I his software package includes a simple Microsofte Excel spreadsheet template
that looks like the paper version of the Oil Conservation Division’s (OCD’s)
C-115 Monthly Production Data Report. The “Add-in” module included with
this package processes data from this spreadsheet and creates a “Flat File,” which the
operator may then submit to the OCD as an attached file via electronic mail or on a
3.5-inch diskette via U.S. Postal service.

NOTE: This reporting package will only work in conjunction with
Microsoft® Excel 97 or newer versions. If you are running a non-supported
version of Excel, you will need to upgrade to a more recent version.

Getting Started with C-115 Electronic Filing

Determine which version of Excel you have

Microsofte Excel’s product information screen will identify which version of Excel
you are curtrently running on your PC. To access that information, follow these
simple steps:

1. Start Excel and select “Help” from the pull-down menu.

2. Select the menu item “About Microsoftg FExcel” and read the version number

that appears in the pop-up window on your computer. Notice the Microsofte
Excel 97 version identifier in the illustration on page 2.

Determine if you need to upgrade your C-115 software

If you believe you have an older version of C-115 software, check for software
upgtades at the “GO-TECH” web site (http://octane.nmt.edu) ot contact the
Petroleum Recovery Research Center (PRRC) or the OCD office.

Via the Internet:
0 Visit http://octane.nmt.edu/dataserv/C115info.asp using any standard
web browser. Software can be downloaded from here to your computer.
By Phone or E-Mail:
0 Annette Carroll (PRRC) at 505-835-5981 or acarroll@prre.nmt.edu
0 Martha Cather (PRRC) at 505-835-5685 martha@prrc.nmt.edu

0 Jane Prouty (OCD) at 505-827-1109 JPROUTY (@state.nm.us




NOTE: For Internet
Downloads, use a
right click of your
mouse button to
save the files to
disk.

PROGRAM ACQUISITION AND INSTALLATION

Microsoft® Excel 97

Copyright@ 1985-1996 Microsoft Corporation, All rights reserved,
International CorrectSpell™ spelling correction system
©1993 INSO Corporation. All rights reserved.

Microsoft Map Program. Copyright®
1995-1996 Mapinfo Corporation. All rights reserved,

This product is licensed to:

PRRC
NIl TECH
Product ID: 53491-806-2074026-35951

Warning: This computer program is protected by
copyright lawe and international treaties, Unauthorized
reproduction or distribution of this program, or any
portion of it, may result in severe civil and criminal

penalties, and will be prosecuted to the maximurm extent
possible under the Iz, Tech Support |

Excel’s Version Identifier Screen

Systerm Info...

Program Installation

BEFORE YOU BEGIN: ILocate the “XLStart” and “Template” folders on your
computer. The C-115 Program Files included in this package must reside within
the appropriate folders on your PC i order for the software package to work. For
help on Locating Folders on your PC, sce page 4 (Using Windows Explorer to
Locate Files and Folders.). See also, Using Windows Explorer to Place Files into
Folders using “Copy and Paste” or “Drag and Drop.”

Installation from the Internet

Open Internet Explorer or any web browser and go to
http://octane.nmt.edu/dataserv/C115info.asp . In the center of your screen appeats
“C-115 Filing Downloads.”

1. "Download” the Spreadsheet Template (CI15Template.xls) to your
Template Folder.

2. Return to your web browset. "Download" the Add-In Filing Module to your

root ditectoty (usually C:\), changing the file extension from xls to .xla as you
save it to disk. The file is now saved as C:\C115.xla.

3. Move the Add-in file (C115.xla) from your root directory to your “XILStart
Folder.”




Copy “C115.xla”
to Excel’s
“XiStart” folder

Test the installation by
running Excel and noting
whether “C-115 Electronic
Reporting” has been added
to the Tools pull-down
menu.

PROGRAM ACQUISITION AND INSTALLATION

Installation from Diskette

1. Insert the C-115 Program diskette into Drive A:\. This diskette contains two files:

e (Cl115xla (Add-in file for processing C-115 teports; allows you to create an electronic reporting
file that is suitable for submission to the OCD) and
e Cl15Templatexls (Spreadsheet file closely resembling the C-115 paper copy).

2. Copy the Add-in file (C115.xla) from the diskette to your “XIStart” Folder.

3. Copy the C115Template.xls file from the diskette to your “Template” Folder.

Finalizing the Installation

Start Excel. To test that the Add-in is available, select "Tools" from the pull-down
menu. A new menu item “C-115 Electronic Reporting” should appear near or at the
bottom of the menu. If you don’t see this, try shutting down and re-booting your
computer. Once installed in the “XIStart” Folder, this new option will appear in every

Excel spreadsheet.

Note: If you are running Windows 95, be certain to go to the "Tools" pull-down
menu, select "Add-ins,” and check the “NM ONGARD C-115" Add-in from the list to

activate it.

Add-Ins K E |
fdd-Ins awvailable:
v File Conversion Wizard ;I
¥ Internet Assistant Wizard eree] |
Browse, .. I

W Lookup Wizard

[~ Microsoft AccessLinks Add-In

W Microsoft Bookshel Integration

[ M5 Query Add-in for Excel 5 Compatib

™ MM ONGARD C-115

™ CDEC Add-In

v Report Manager

¥ solver Add-In |

rConditional Sum YWizard
Helps you create Formulas to sum selected data in lists.

Program nstallation is now complete. Software upgrades will be posted to the Internet
as they become available.
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Locating Files and Folders with Windows Explorer
Open Windows Explorer or Windows NT Explorer and follow the steps below.

1. From Explorer’s menu select “Tools” and “Find” “Files or Folders.” At the
screen shown below, type in “XLStart” or “Template” as the file or folder
name; select the drive you wish to search[(C:] in this case); select “Find Now.”

BN Exploring - [C:]

File Edit “iew KR Help
WFDMEIS EI|E- ar Folders. .
Use “Fine 1 T oo G ]
Locate Files D% ml- B e i bt sl E!!e ED!E!E[
and Folders ERREN 2N Find: Files named xlstart
[58 N Bl Edi View Options Help
-1 Progran
8 Quaran MName & Location I Cate Modified I Advanced I
[+ R aplay :
@& Rden | Find Haow I
..... Q ?fciycjl Hamed: |Hlstart j Stop |
Find files Laak in: IE j Browse. .. | Mew Search |
V¥ Include subfolders {%
M arme | |n Folder | Sizel Type | k¢
& b C:WProgram Fileshbdi. .. File Folder 3
[ CAMSOffice\Excel File Folder o
1] |

|2 filelz) found | |

The folder is found. If leading dots (....) appeat under "In Foldet" as shown, expand
the “In Folder” window to view the complete path and make a note of the path.

Using Windows Explorer to Place Files into Folders

Using “Copy and Paste”

1. Use yout left mouse button to highlight drive A:\ and note that “C115.xla”
and C115Template.xls. files are listed (see 1llustration on the following page).

2. Select the “C115.xla” file; next select “Edit” from the pull-down menu and
select “Copy.” This action will copy the file to the Clipboard.
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5‘ Exploning - 3% Floppy [A:]

File Edit Wiew Toolz Help

|AII Folders | Contents af 3% Floppy [&:]'
@ Desktop || Mame | Sizel Type | b odifie
EI--- My Computer %EHE 204KB  Microsoft Excel Adddn 411720
"@ 3% Floppy [4:] 2 C115Template B8KB  Microsoft Excel Wor..  11/264
i (C)
{11 $oemd
-7 Backup
{7 Cdram
-2 Dell
{"_‘| Dos
-] dowrload
-1 Drviib =l | D
|2 obiects) |262KB [Disk free space: 1.13MB) v

3. Use Windows Explorer to locate the “XLStart” Folder. Highlight the folder.
Select “Edit” from the pull-down menu and select “Paste.” The file is now
pasted from the Clipboard to the Folder. If you double-click the “XILStart”
Folder , you will see that the “C115.xla” file resides within the correct folder.

B Exploring - XL5tart M= E3
Fil= Edit “iews Toolz Help
|.~’-‘-.II Folders | Contents of =LStart!
{:I Queries ﬂ M arme | Sizel Type | bd odifie
3 Samples %0115 204KB  Microsoft Excel Add-n - 4/17/2(0

(23 5bt
{2 Shortcut Bar
(2 Startup

[0 wlakars
23 e

w0 Templates J
- Mis
B3 Qualcomm
-2 Rand McMally LI 1 | _pl
|1 object(z) |204KE (Disk free space: 9.20GE) 4

Using “Drag and Drop”

1. Highlight drive A:\ with your mouse.

2. Use your left mouse button to select “C115.xla” and, continuing to hold down
your mouse button, drag the file to your “XlStart” Folder. Follow the same
procedure with C115Template.xls, dragging it to the “Template” Folder. If
these folders are several layers deep, using “Copy” and “Paste” as described
above may prove easier.

NOTE: If you are using a network you may need to get permission from your
network administrator to do this.

The next section of the manual provides instructions on how to configure the
Add-in Module to work with your template.




REQUIRED

INFORMATION

OGRID number

Contact name

Contact phone

ooo|0

The columns in your
spreadsheet that
contain the required
data (if NOT using
the template)

O Name of output file

PROGRAM CONFIGURATION

Section

Program Configuration

Confignring the Report Add-in Module is fairly simple if you use the
spreadsheet template provided with this package. 1f you decide to use your own
exsting spreadsheet, the setup will be somewhat cumbersome and it will require
that you pay very close attention to various setfings.

he C-115 spreadsheet template provided with this package is designed to look

like a standard C-115 paper form. The Report Add-in included in this package

1s configured to work with the layout provided in the template below. To
configure this Add-in requires that you have several pieces of information at hand (see
requirements box at left). Most of the examples in this section assume that you will be
using the packaged template spreadsheet. If this is not the case, you will have to
identify the location of the required reporting information in your existing spreadsheet
and reconfigure the Add-in’s “Column Settings” screen.

C-115 Spreadsheet Template

|E] Fle Edit Wew Insert Format Tooks Data Window Help 1= x|
D8 SRy B[ &2 A gl B 2 |wssmssar Hs -BruSEE=E$%, % -d-A-2
A1 | =
A B [T o T E TF & T H [ T Ft TRT L [ WM T W [ 0 [ P TG R [

| 4 State of New Mexico Form C-11% First Page
[ (5 | P.0.Box 1950, Hobbz, MM 55241 1950 Encrgy. Mincralz & Hataral Rezources Department Revised October 17, 1993
| B Distictll 0OIL CONSERVATION DIVISION Instiuction on Reverse Side
| 7 | P.0.Drowsr DD, Artacia, NM 88211-0719 P. 0. Box 6429 1 D Amended Report
| 8 | Santa Fe, NM 87505
| 9 | 1000FRic Brazoz, dates, N 54710 OPERATOR'S HONTHLY REPORT

0

11 2 Operator Harvard Petroleum Corparation 3 OGRID: 010155 |4 Month/Year 3/98

12 5 Address: PO Box 936, Roswel, Ni 88202-0336 |B Page 1 of 4

kl INJECTION PRODUCTION DISPOSITION OF DIL, GAS, AND WATER

4 Fi 3 n 12 16 19 E 23
[ 15 POOL HO. AND NAME c © | Barels of 13 [0 15 [ 17 1€ [Dilonhand 20 21 ¢ | Dilon
[ 16 Property Mo. asd Hame o g 10 |0 |Dillconden| Barrels of | MCF | Dags [0 | Pointof | Gas BTU at Yolume | Transporter |O | hand at
[17 ‘well Ho. & U-L-5-T-R D |Yolume|Pressure |D sate water Gas | Prod- [D Di i or Ol API | beginning Ogrid D | end of
18] APl Ha. E E | produced | produced uced |E Gravity | of month E | month

1 2 3 0

[20
[ 21 | 005072 Harvard State
[ 22| 001 B-27115-33E
[ 23| 30025-28015 P 0 1) 208 A [0 10746101 93| 93
| 24 G 1074630/ 1410 208| 024650
| 25 22800 Fumont Yates Seven Bivers Queen
| % 020087 Coll
| 27 | 001 1-33-205-36E
| 28 | 3002504322 [ 0 0 o o
[ 29| 002 P-33-205-36E
[ 30| 30-025-04383 T 0 0] o o
[ 31| 004 0-33-205-36E
[ 32 | 30-025-04385 F 5 0| o 1 |0 0947610] 12| 148410 17}
[ 33 G 0947630/ 1] 1] 009171
|34 020088 Gulf State
[ 36| 001 V-00-215-35E
[ 36| 3002503335 [ 45| 0 164 29
[ 37 | 002 01-215-35E
[ 38| 3002503386 P 129 0] 468 29
|23 003 01215356
| 40| 30-025-03387 P 129 0| 468 29
| 41 004 501215358
[ 42 | 30.025-03338 F 45| 1] 165 23 [0 0347710] 34.4 125) 170] 143410 304]
| 43 G 0947730/ 1310 1265 003171

20 i
144 [M} c115 141 | |
Ready 1 I o




For a first-time
setup you will run
Excel using the
template file and
save the output
file as
C:\C115TEST.TXT

PROGRAM CONFIGURATION

Configuring the Add-in Module

The Add-in module is not difficult to configure if you follow the procedure outlined
below. After the module’s initial run, many of the data items will be remembered
automatically by your registry file. (Note: If you reset the registry file, these items
will return to their default values.)

Start Excel.

From the “File” pull-down menu select “Open”

1
2
3. Browse for the file “Template.xls” and double-click to open it
4. Select “Tools” from Excel’s pull-down menu

5

Choose “C-115 Electronic Report” from the menu. When selected, the Add-in
launches a dialog box, like the one illustrated below. Information requirements for
each tab are outlined on the following page. Note: Move from tab to tab, filling in
the required information before clicking the OK button.

ON THE C-115 REPORT SETTINGS TAB:

Enter your cotrect OGRID number

Enter a month

Enter a year (use four digits, any year is okay)
Enter the correct contact name and phone number

e NS

NOTE: The information entered in this screen must match the information
entered in your template Header fields.

C-115 Electronic Reporting Information

C-115 Report Settings I Calurnn Settings I Dutput File |

[~ &mended Feport?

OGRID [ 014534

R t kMonth I
= {one of bwo digit report maonth, 1 theu 123
Repart *'ear I (Four digit wear af period being reported)

Contact Mame I Flobert Emery

Fhane | (505) 2355951

ak Cancel |
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ON THE COLUMN SETTINGS TAB:

No changes are required if you are using the template file. If you plan to use a pre-
existing spreadsheet, see Section 3; you may need to change column settings.

NOTE: You can C-115 Electronic Reporting Information
avoid column _
reconfiguration C-115 Report Settings  Column Settings ] Output File |
if you use the
template Fool/Producing Property Columi 34 [rayz Produced Colurmn 10
AP Wwell Humber Calumn 2 Code 3 Calumn 11
Code 1 Column 3 Foint of Dispozition Caolurmn 12
Imjection Yolume Column 4 Gaz BTUAAPI Gravity Column 13
Injection Preszure Column 5 Beginning Oil Storage Column 14
Code 2 Column g Dizpozition Yalume Calumn 15
il Production Colurmn 7 Tranzporter OGRID Colurmn 16
W'ater Production Columnn a Code 4 Calumn 17
Gaz Production Column q Ending Oil Starage Colurmn 18
(] | Cancel |
ON THE OUTPUT FILE TAB:
NOTE: After the initial 1. Enter a report file name like “C:\C115TEST.TXT”. This is your dummy
setup, saving a Confir- output file that will place the configuration settings in your Windows Registry
mation Sheet to disk file.

each month isn’t
necessary, but it’s a
quick way to check
whether the Add-in has
correctly processed
data from your Cc-115 Report
spreadsheet. Uncheck
the box if you don’t
wish to save the file.

2. Enter a confirmation sheet file name like “C:\C115CONF. TXT”

C-115 Electronic Reporting Information

C-115 Repart Settings ] Caolumn Settings  Output File l

File Path Mame | ANCTTEDATA THT

[ Confirmation Sheet

File Path Name | 41c115CONFTST

s Leading -:‘“ Mo Leading
Mumber Mumber

Ok | Cancel
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3. Select OK. [Windows may ask you if you are ready to report to diskette A:\. If
you do not plan to save it to the external drive A:\ drive, you'll need to change
the file path to your desired destination drive.] If everything works correctly,
you should see a dialog box like the one below.

C-115 Processing E |

(C-115 Rows Processed 216

E-Report Rows Generated | 75
Confirmation Sheet Rows | 35

Exit |

Yout dummy output file (C:\C115TEST.TXT) has now stoted the configuration data
in your Windows Registry file. The next time you use the Add-in it will remember the
OGRID number and contact information. You will only need to enter the date
information and whether or not this is an amended report.

NOTE: To retain each month’'s Report Data file, save it under a different name at the
screen shown on the previous page (Output File tab). If you decide to change the filename
when you see the screen below and you click “Cancel,” the module’s action will cancel and
you will have to run the report Add-in again.

C-115 Electromic Reporting ] i

@ A file named C:ACT1E0ATA TXT [B6.058 bytes, created 8/28/38 8:28:08 AM] already existz.

Do pow want to delete the exizting file?

: Hao I Cancel I

The next section describes in detail how to use the spreadsheet template and includes a
list of common problems and their solutions.
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Section

Using the Template

The C-115 template is a simple Excel spreadsheet, but you
do need to stay consistent in how you enter the data.
(WAMING: It is important to keep your report data for each

month in a different Workbook because the Add-in takes data from
ALL of the Worksheets in the current Workboolk.)

he spreadsheet used in this program 1s simple; all you are required to do
1s enter the correct data in the appropriate column. If you are reporting

on a fair number of wells, you may need to add more worksheets to
your template. To save time and to ensure that all your worksheets are
processed correctly, change the Operator Headings in your template before you
add more worksheets.

Adding Worksheets to the template Workbook

With your template open in Excel

Select “Edit” from Excel’s pull-down menu (or right-click your mouse) and
select “Move or Copy Sheet.” In the pop-up window like the one shown,
click the box “Create a Copy” (lower left-hand corner of the window) and
highlight (move to end); click “OK.”

Move or Copy E | You now have a new worksheet

mnto which you may enter data.

Move selected sheets .
Repeat this procedure as many

11355 times as needed. Remember that
IEK":"I'”“":'LE'MS j worksheets must remain in 1,2,3
Before sheet: order, starting from the left of the
c115 = Workbook. Excel reads data from

left to right, so any discrepancies in
sheet order will produce a corrupt
data file. If you don’t highlight

I (move to end) before clicking OK,
Excel will place your new

worksheet out of sequence; grab
it I e | the tab with your mouse and drag it
to the appropriate position.

=10 -



Double-click
bold items
and enter
replacement
data for Pools,
Properties,
Wells, etc.

PROGRAM CONFIGURATION

Entering Data to Your Customized Template

Each of the columns processed by the electronic reporting Add-in are briefly
described below. For the Add-in to work correctly you must follow the
reporting conventions described below and you must also change the
mformation in the Operator Headings.

Column A

This column should remain blank. No data is required in column A.

Column B

1. Enter the 5-digit pool number followed by the pool name (in the same
cell); use both uppercase and boldface.

2. In the next row enter the 6-digit producing property ID followed by the
property name (in the same cell) (leading zeros are important), this
time use lowercase and bold face.

3. In the next row enter the well number followed by the unit letter-
section-township-range (U-L-S-T-R) location for the well.

4. In the next row enter the well’s API code (dashes are important).

7 9 10 1
EO0L M0, AR RARME !
Fraoperty Mo, and Mame |
well Mo, & U-L-5-T-R

&P Ma.
13379 COUNSELORS GALLUP-DAKOTA
007736 Annie
001 L-10-23N-08WY

Wolume | Pressure

—mog 0

J0-0:39-235043 =
003 G-10-23MN-08WY
J0-039-23170 F

Repeat steps 3-4 for each well within that property ID. Repeat the entire
procedure for each different Pool and Property ID.

Column B - “Code 1”7 (Well Status)

Enter one of the following acceptable entry codes:

1. (F) Flowing 5. (T) Temporarily Abandoned
2. (P) Pumping 6. (I) Injection Well

3. (G) Gas Lift 7. (D) Salt Water Disposal Well
4. (S) Shut-in 8. (A) Plugged and Abandoned

-11 -



PROGRAM CONFIGURATION

Column D - Volume

Enter the number of barrels of water or MCF of gas injected. This requires
clarification on type of entry (e.g., 5 BW or 10 MCF).

Column E
Enter the mjection pressure (PSIG).

Column F - “Code 2” (Type of Injected Fluid)

Enter one of the following acceptable entry codes:

1. (W) Water
2. (G) Gas
3. (C)CO,
4. (O) Other
Column G

Enter the number of barrels of crude oil or condensate produced for the
month.

Column H

Enter the number of barrels of water produced for the month.

Column |
Enter the MCF of gas (includes CO,) produced for the month.

Column J
Enter the number of days that the well produced during the month.

Column K - “Code 3” (Type of Product)

Enter one of the following acceptable entry codes:

1. (G) Gas (includes CO,)
2. (O) Crude O1l, Condensate, Drip
3. (W) Water

-12-
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Column L

Enter the point-of-disposition (POD) number (7-digits) for each product
transported from the property or enter the non-transported volume that effect
oil storage balance.

Column M

Enter the gas BTU in effect for the gas volume transported (adjusted to 15.025
PSIA at 60° F) or enter the weighted average API oil gravity of oil transported.

Column N

Enter the beginning oil storage volume for the current reporting month.

Column O

Enter the volume of oil, gas, or water transported or otherwise dispositioned
(lost, vented, spilled, used on property, etc).

Column P
Enter the transport OGRID number.

Column Q - “Code 4” (Non-transported
Disposition)

Enter one of the following acceptable entry codes:

For oil:
1. (©) Circulating Oil
2. (S) Sedimentation
3. (L) Lost
4. (T) Theft
5. (O) Other

For Gas:
1. (G) Gas Lift
2. (R) Repressurizing
3. (V) Vented
4. (U) Gas used on property
5. (L) Lost
6. (O) Other

-13 -
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For Water
1. (I) Water re-injected on property
2. (P) Pitted
3. (A) Evaporated
4. (O) Other
Column R

Enter the ending o1l storage volume.

Remaining Columns

No data is required in the remaining columns.

Creating and Submitting Your C-115 Report

When you have completed entering data into your template, run the Add-in to
create the “Flat File” for transmission to OCD using the following procedure:

1. With your final template open, go to the “Tools” pull-down menu;
select C115 Electronic Report: OGRID, Report Month, Report Year,
Contact Name, and Phone must match your Template Headings for the
month/year you are reporting. If you are filing an Amended treportt,
contact the OCD directly for information on filing amended reports.

C-115 Electromic Reporting Information

C-115 Repaort Settings I Column 5 ettings | Output File

[ amended Feport?

OGRID | 014534

Report Month I
SR e fone or bwo digit report month, 1 thro 12)
Report ‘rear I (Four digit vear of period being reported)

Contact Mame I Fiobert Emery

Phone | (505) 5355951

0k Cancel |

-14 -
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2. Move to the Output File Tab (as shown below) and enter the correct
file name(s). If you intend to save a separate file for each month’s
output, choose a file name that reflects the month for which you are
reporting; otherwise, you can simply overwrite the file.

C-115 Electronic Reporting Information
C-115 Repar Settings | Column Settings  Output File I

C-115 Report

File Path Mame I AACTTBDATA T=T

[¥ confirmation Sheet

File Path Name | 4., c115CONF T<T

" Leading - Mo Leading
Murmber Mumber

Ok I Cancel

3. Click OK. You will see a screen like the one below indicating that the
module 1s running the Add-in.

C-115 Processing E |

(C-115 Rows Processed 216

E-Report Rows Generated | 75
Confirmation Sheet Rows | 35

Exit |

4. Click the Exit button. Locate your Output data file (saved either to
your hard drive or to diskette). A sample Output file is shown on the
following page.
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B C115TEST1 - WordPad =10l x|

File Edit Yiew Insert Format Help

D[] SR @ 8- B

lelSSNQBDSDDllZ?Dianna Nowvak S05-623-15581 OMPRRCOS0317 1
036203002525015P00000000000000 00000000000000000020831
0352000507201074610000000000000530000000000000 0000093
03520005072G1074630000141000000000000205024650 0000000
228003002504352P00000000000000 00000000000000000000000
Z2Z28003002504353TOO000000000000 0O0000000000000000000000
228003002504355F00000000000000 00000050000000000000001
2280002008700547610000000000000120000000149410 0000017
22800020087G0947630000000000000000000000002171 0000000
Z2Z80030025033585P00000000000000 00000450000000000016429
228003002503356P00000000000000 00001290000000000046829
2280030025033587P00000000000000 00D001290000000000046829
228003002503385F00000000000000 00000460000000000016629
Z2Z8000200850094771000034. 400001250000170149410 0000304
22800020088G0547730000131000000000001265009171 0000000
228003002503452F00000000000000 00000010000000000000031
228003002503453P00000000000000 00002880000000000006820
Z2Z28000200890094751000031.800000150000155149410 0000153
22800020089G0547830000125000000000000065009171 0000000
228003002503442F00000000000000 00000000000000000000000
228003002503443F00000000000000 00000000000000000000000
228003002503 444F00000000000000 00002 570000000000000084
228000200890054721000038. 300000640000160149410 0000161
372403002510805P00000000000000 O0000S60000162000001923
37240300252 6513P00000000000000 00000330000073000014426
372403002525044P00000000000000 000008700002 50000007731
372400209730054521000034. 6000019700001650156594 0000235 _J

-
For Help, press F1 MUM

Sample Output (Flat) file. This 1s the file you will send to the OCD.

|»

oL L) L)L W LW W W W LW W W

The easiest way to submit your report is to attach the file to an electronic mail
message (e-mail) and send it via e-mail to nmc115@state.nm.us. Most e-mail
programs support file attachments but if yours does not, copy the file to a 3.5”
diskette and mail the diskette to:

C-115 Electronic Filing

Oil Conservation Division

NM Enetrgy, Minerals and Natural Resources Department
2040 S. Pacheco Street

Santa Fe, New Mexico 87505

Common Problems

The Add-in package 1s not particularly sophisticated in how it processes data in
your spreadsheet, so you may expetience some problems. Some of the more
common problems encountered are noted on the following page. Please use
this guide to troubleshoot errors associated with your file. If you are still baffled
and need help, contact Annette Catroll or Martha Cather of the PRRC at the
phone numbers or e-mail addresses provided in Section 1, page 1.
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Template Troubleshooting Guide

COMMON

PROBLEMS

Problem

Solution

Nothing happens when I press the OK
button on the Add-in.

One of the data fields in the Report Settings

screen 1s not filled out correctly.

®  Check that you are using 4 digits for the
yeat.

®  Verify that the column numbers specified
for each of the data items on the Column
Settings tab match those in the
spreadsheet.

How do I know if the cotrect data has made it
into the transmission file?

Examine the Confirmation output file you
created with the Add-in and saved to your
floppy disk or elsewhere on your hard drive.

Why does the Add-in find so many rows to
process?

The Add-in reads every row in each
worksheet contained in the currently open
Workbook. Excel usually creates at least three
worksheets per Workbook.

Can I use other columns in the worksheet for

other purposes?

Yes, but don’t use the columns specified in
the Column Settings of the Add-in for any
other type of data.

My data file contains xxx’s and yyy’s and my
Confirmation sheet does not look cottect.

Your worksheets may be out of order. If you
have several worksheets in your workbook,

they must follow in 1,2,3 sheet order, starting
from left to right. Reorder them if necessary.

I get a Windows Run Time etror 91......
when I try to process the data sheet.

This message usually indicates a programming
error. Check your worksheet to confirm that
you have entered the data cotrectly (see data
entry instructions found in this section).
Check that the information found in your
Report Settings Screen of the Add-in Module
matches your Template Operator Headings
(e.g., month and year must match in both).
These entries will change each month and
they must match in both locations.

I’m told my test file did not come through
correctly for processing through the OCD’s
ONGARD system. What did I do wrong?

Check the formatting on your data entties.
Specifically, review the steps listed for Column
B. Extra spaces in front of Pool or Property
ID’s can sneak in and cause problems.

If you encounter other problems or find solutions to problems that are not
mcluded i this list, please notify us. We welcome your input in helping us
better serve current and future users of this software.
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